GENERAL INSTRUCTIONS

Candidates should read the following instructions carefully before answering the questions:

1. Verify the seriality of the page numbers. If there is any discrepancy, bring it to the Invigilator’s notice immediately.

2. All the boxes, ovals and the entries in the Answer Sheet must be filled up using Black Ballpoint Pen only.

3. Before you mark in the Answer Sheet, please fill the following in the appropriate places:
   - Write name of the Examination Centre.
   - Write your full name in Capital Letters.
   - Put your Left Thumb Impression and Full Signature.
   - Write your Roll No. (10 digits) and darken the corresponding 10 ovals.
   - Darken the oval corresponding to your Category.
   - Darken the oval corresponding to your Booklet Code (A, B or C).
   - Darken the oval to denote your Gender.

4. All questions are of Multiple Choice Answer type. Answer all the questions. Please darken only one of the four probable answers [A], [B], [C] or [D]. Darkening more than one oval means you are writing a wrong answer.

5. There will be negative marking for each wrong answer @ 1:4.

6. There are blank pages at the end of this Booklet for Rough Work. Roll No. must be written on the blank sheet used for Rough Work. The sheet should not be torn out of the Question Booklet.

7. Hand over the OMR Answer Sheet to the Invigilator before leaving the Examination Hall.

8. Please do not leave the Examination Hall until the examination is over.

9. Please do not fold, scratch, scrimp or tear any portion of the Answer Sheet by any chance as this will render the Answer Sheet unsuitable for computer evaluation. Keep the Sheet away from gum.

10. Please ensure that the blank dotted line along the left side of margin of side 1 as also the right side of side 2 is not damaged in any way as it may affect the computer evaluation.

11. If error is detected in any particular question, the candidates are advised not to attempt the same. The Commission do not award any marks to questions having any type of error.
1. *Nil Darpan* was written by

[A] Dinabandhu Mitra  
[B] Harish Chandra Mukherjee  
[C] Bankim Chandra Chatterjee  
[D] Ramesh Chandra Dutta

2. Electrical energy is converted into mechanical energy by a

[A] thermostat  
[B] motor  
[C] dynamo  
[D] rectifier

3. Kuchipudi is one of the classical dance forms of the State

[A] Andhra Pradesh  
[B] Kerala  
[C] Odisha  
[D] Tamil Nadu

4. In which year was the Reserve Bank of India established?

[A] 1935  
[B] 1940  
[C] 1947  
[D] 1949

5. Who is the author of *Playing it My Way*?

[A] Sachin Tendulkar  
[B] Yuvraj Singh  
[C] Sunil Gavaskar  
[D] Anil Kumble

6. During whose reign the East India Company established their first factory in India?

[A] Jahangir  
[B] Shah Jahan  
[C] Aurangzeb  
[D] Bahadur Shah I

7. ‘Dry ice’ is made up of

[A] water  
[B] chlorine  
[C] hydrocarbon  
[D] carbon dioxide

8. Name the State which has won the Santosh Trophy in the year 2016-2017.

[A] Kerala  
[B] West Bengal  
[C] Maharashtra  
[D] Punjab
9. Who has won the Wimbledon Lawn Tennis Championship this year?
   [A] Roger Federer
   [B] A. Murray
   [C] N. Djokovic
   [D] S. Wawrinka

10. Who wrote Three Idiots?
    [A] Arundhati Roy
    [B] Chetan Bhagat
    [C] Aravind Adiga
    [D] None of them

11. Who said ‘Sab lal ho jayega’?
    [A] Guru Gobind Singh
    [B] Ajit Singh
    [C] Tegh Bahadur
    [D] Ranjit Singh

12. Who was the first Governor-General of Independent India?
    [A] Jawaharlal Nehru
    [B] Dr. Rajendra Prasad
    [C] Raja Gopalachari
    [D] Lord Mountbatten

13. X-ray fails to pass through
    [A] flesh
    [B] bone
    [C] iron
    [D] gold

14. Who has been adjudged the best actor in the National Film Award, 2016?
    [A] Amir Khan
    [B] Akshay Kumar
    [C] Shah Rukh Khan
    [D] Ranveer Singh

15. Who has become the new Brand Ambassador for ‘Swachh Bharat Mission’?
    [A] Shilpa Shetty
    [B] Priyanka Chopra
    [C] Deepika Padukone
    [D] Kangana Ranaut

16. India Wins Freedom was written by
    [B] Sardar Vallabhbhai Patel
    [C] G. B. Panth
    [D] None of them

17. Name the country which won the last FIFA World Cup.
    [A] Brazil
    [B] Germany
    [C] France
    [D] Argentina
18. Quit India Movement was started in the year
[A] 1940
[B] 1941
[C] 1942
[D] 1945

19. Who has been awarded the Nobel Prize on literature in the year 2016?
[A] Svetlana Alexievich
[B] Bob Dylan
[C] Moe Yan
[D] Tomas Tranströmer

20. How many Schedules are there in the Indian Constitution?
[A] 8
[B] 12
[C] 9
[D] 6

21. Who wrote *One Life is Not Enough*?
[A] Jaswant Singh
[B] Shashi Tharoor
[C] Natwar Singh
[D] Vinod Rai

22. Bauxite deposits are found in
[A] Jharia
[B] Badampahar
[C] Lohardaga
[D] Haldia

23. Scurvy is caused by the deficiency of
[A] vitamin D
[B] vitamin B
[C] vitamin C
[D] vitamin A

24. Where is Integral Coach Factory situated?
[A] Perambur
[B] Chittaranjan
[C] Mumbai
[D] Kapurthala

25. The first metal discovered by man was
[A] iron
[B] aluminium
[C] zinc
[D] copper

26. Neapnagar produces
[A] copper
[B] milk
[C] newsprint
[D] contact lens

27. Light-year is a unit of
[A] time
[B] distance
[C] light
[D] intensity of light
28. The Right to Education for all between 6 years and 14 years of age has been included as a fundamental right in the Constitution in the year

[A] 1998  
[B] 2001  
[C] 2002  
[D] 2000

29. ___ is the most industrially advanced State in India.

[A] Maharashtra  
[B] Punjab  
[C] Gujarat  
[D] Tamil Nadu

30. Who is the present Chief of Army in India?

[A] Dalbir Singh Suhag  
[B] Bipin Rawat  
[C] V. K. Singh  
[D] J. S. Arora

31. The background color or effect applied on a document is **not** visible in

[A] reading view  
[B] print layout view  
[C] web layout view  
[D] print preview

32. The minimum numbers of rows and columns in MS-Word document are

[A] 1 and 1  
[B] 2 and 1  
[C] 1 and 2  
[D] 2 and 2

33. What are the smallest and largest font sizes available in Font Size Tool on formatting toolbar?

[A] 8 and 72  
[B] 8 and 64  
[C] 12 and 72  
[D] 12 and 64

34. What is the default font used in MS-Word (MS-Word 97–2003) document?

[A] Times New Roman  
[B] Arial  
[C] Algerian  
[D] None of the above

35. Which one of the following is **not** a function in MS-Excel?

[A] SUM  
[B] AVG  
[C] MAX  
[D] MIN
36. In Excel, columns are labeled as
   [A] A, B, C, etc.
   [B] 1, 2, 3, etc.
   [C] A1, A2, etc.
   [D] $A$1, $A$2, etc.

37. Which function in Excel is used for creating a data table?
   [A] Sum
   [B] Table
   [C] Add
   [D] Count

38. What is the shortcut to enter current date in cell in Excel?
   [A] Ctrl +;
   [B] Alt +;
   [C] Shift + &
   [D] Ctrl +$

39. To convert a column of data into row, which command will you choose?
   [A] Edit→Paste Special→Transpose
   [B] Cut and Paste
   [C] Both [A] and [B]
   [D] None of the above

40. Which key can be used to view PowerPoint Slide Show?
   [A] F5
   [B] F2
   [C] F7
   [D] F9

41. In MS-Word, for what does ruler help?
   [A] To set tabs
   [B] To set indents
   [C] To change page margins
   [D] All of the above

42. What is the function of Ctrl+P in MS-Word?
   [A] Open the Print dialog box
   [B] Update the current Web page
   [C] Close the current window
   [D] None of the above

43. If you need to change the typeface of a document, which menu will you choose?
   [A] Edit
   [B] View
   [C] Format
   [D] Tools
44. Which function in Excel checks whether a condition is true or not?
   [A] SUM  
   [B] COUNT  
   [C] IF  
   [D] AVERAGE

45. On an Excel sheet, the active cell is indicated by
   [A] a dotted border  
   [B] a dark wide border  
   [C] a blinking border  
   [D] an italic text

46. Protection and the protect Excel Sheet options can be selected from
   [A] Data  
   [B] Tools  
   [C] Edit  
   [D] Format

47. If you want to insert some slides from other PowerPoint presentation into current one
   [A] from Insert menu choose Slides from files  
   [B] from Edit menu choose Slides from presentation  
   [C] from Slide Show menu choose slides  
   [D] None of the above

48. Which of the following will not advance the PowerPoint slides in a slide show view?
   [A] Mouse button  
   [B] Enter key  
   [C] Spacebar  
   [D] Esc key

49. Which one of the following is not a search engine?
   [A] Bing  
   [B] Google  
   [C] Yahoo  
   [D] Facebook

50. Internet Explorer falls under
    [A] operating system  
    [B] compiler  
    [C] browser  
    [D] IP address

51. Which of the following is not a font style?
    [A] Bold  
    [B] Italic  
    [C] Regular  
    [D] Superscript

52. Portrait and Landscape are
    [A] page orientation  
    [B] paper size  
    [C] page layout  
    [D] All of the above
53. Text-styling feature of MS-Word is
   [A] word color  
   [B] word font   
   [C] word art    
   [D] word fill

54. To apply centre alignment to a paragraph, we can press
   [A] Ctrl + S
   [B] Ctrl + C
   [C] Ctrl + C + A
   [D] Ctrl + E

55. Which one of the following can be used as watermark in a Word document?
   [A] Text
   [B] Image
   [C] Both [A] and [B]
   [D] None of the above

56. Which of the following will **not** cut information?
   [A] Pressing Ctrl + C
   [B] Selecting Edit→Cut from the menu
   [C] Clicking the Cut button on the standard
   [D] Pressing Ctrl + X

57. How many sheets are there by default, when we create a new Excel file?
   [A] 1
   [B] 3
   [C] 5
   [D] 10

58. The functions in MS-Excel must begin with a/an
   [A] () sign
   [B] equal sign
   [C] plus sign
   [D] > sign

59. From which menu, you can access picture, text box, chart, etc., in PowerPoint presentation?
   [A] File
   [B] Edit
   [C] Insert
   [D] View

60. Which of the following is a correct format of E-mail address?
   [A] name@website@info
   [B] name@website.info
   [C] www.name of website.com
   [D] name.website.com
61. The ratio of the ages of Tina and Rakesh is 9:10. 10 years ago the ratio of their ages was 4:5. The present age of Rakesh is (in years)

[A] 25
[B] 20
[C] 24
[D] 30

62. 15% of 578 + 22.5% of 644 is

[A] 231.4
[B] 233.6
[C] 231.8
[D] 231.6

63. In 120 litres of mixture of milk and water, water is only 25%. The milkman sold 20 litres of this mixture and then he added 16.2 litres of pure milk and 3.8 litres of pure water in the remaining mixture. The percentage of water in the final mixture is

[A] 22%
[B] 21%
[C] 24%
[D] 25%

64. 20 men can complete a piece of work in 16 days. After 5 days from the start of the work, some men left. If the remaining work was completed by the remaining men in $18\frac{1}{3}$ days, the number of men left after 5 days from the start of the work is

[A] 10
[B] 8
[C] 5
[D] 4

65. The average of 15 observations is 18. The average of 9 among these 15 observations is 15. The average of the remaining 6 observations is

[A] 24.5
[B] 24.25
[C] 15.75
[D] 22.5

66. The ratio between three angles of a quadrilateral is 9:11:17. The value of the fourth angle of the quadrilateral is 138°. The difference between the smallest and the largest angles of that quadrilateral is

[A] 60°
[B] 66°
[C] 84°
[D] 90°
67. The total cost of painting a rectangular wall at ₹110 per square foot is ₹10,560. The length of the wall is 4 feet more than the breadth of the wall. The length of the wall is (in feet)

- [A] 10
- [B] 12
- [C] 14
- [D] 16

68. A dealer sold an article for ₹6,120 at a loss of 15%. Had the dealer sold the article for ₹1,728 more, the dealer would have gained (in %)

- [A] 9
- [B] 7
- [C] 5
- [D] 4

69. Four circles having equal radii are drawn with centres at the four corners of a square. Each circle touches the other two adjacent circles. If the remaining area of the square is 168 sq. cm, the radius of the circle is (in cm)

- [A] 14
- [B] 12
- [C] 10
- [D] 8

70. The monthly salaries of Pia and Som are in the ratio 5 : 4. Pia, from her monthly salary gives 3/5 to her mother, 15% towards her sister’s tuition fees, 18% towards a loan and she shops with the remaining amount which is ₹2,100. The monthly salary of Som is (in ₹)

- [A] 25,000
- [B] 24,000
- [C] 30,000
- [D] 20,500

71. A certain amount of money is divided among A, B and C in such a way that A gets ₹40 more than the half of the total amount. B gets ₹120 less than \( \frac{3}{8} \) th of the total amount and C gets ₹200. The total amount of money is (in ₹)

- [A] 1,100
- [B] 850
- [C] 960
- [D] 1,200

72. Hari bought a certain quantity of oranges at a total cost of ₹1,200. He sold \( \frac{1}{3} \) rd of those oranges at 20% loss. If Hari earns an overall profit of 10%, the percentage of profit at which Hari sold the rest of the oranges is

- [A] 16%  
  - [B] 15%
- [C] 22%  
  - [D] 25%
73. A, B, C started a business by investing ₹12,600, ₹19,800 and ₹23,400 respectively. All of them invested for equal period of time. If A’s share of annual profit is ₹2,240, then C’s share of annual profit is (in ₹)

[A] 3,900  
[B] 4,290  
[C] 4,160  
[D] 4,420  

74. The sum of two odd numbers is 38 and their product is 325. The largest odd number is

[A] 21  
[B] 23  
[C] 25  
[D] 29  

75. The average speed of a truck is \(\frac{4}{5}\)th of the average speed of a car. The car covers 520 km in 8 hours. The distance (in km) the truck will cover in 9 hours is

[A] 459  
[B] 468  
[C] 477  
[D] 486  

76. To reach the point B from the point A, at 4 p.m., Sara will have to travel at an average speed of 18 km/hr. She will reach point B at 3 p.m. if she travels at an average speed of 24 km/hr. The average speed at which Sara should travel to reach the point B at 2 p.m. is (in km/hr)

[A] 25  
[B] 32  
[C] 36  
[D] 28  

77. B is 3 years older than A and B is 3 years younger than C. 3 years hence, the respective ratio between the ages of A and C will be 4 : 5. The sum of the present ages of A, B and C is (in years)

[A] 84  
[B] 72  
[C] 63  
[D] 56  

78. A trader sells two bullocks for ₹8,400 each neither losing nor gaining in total. If he sold one of the bullocks at a gain of 20%, the other is sold at a loss of (in %)

[A] 18\(\frac{2}{9}\)  
[B] 14\(\frac{2}{7}\)  
[C] 14\(\frac{2}{9}\)  
[D] 18\(\frac{2}{7}\)
79. Two trains A and B start from the stations X and Y towards each other. They took 4 hours 48 minutes and 3 hours 20 minutes to reach Y and X respectively after they meet. If the train A is moving at 45 km/hr, then the speed of the train B is (in km/hr)

[A] 45
[B] 54
[C] 64
[D] 60

80. The ratio of the radii of two right circular cylinders (A and B) is 2 : 5. The ratio of the heights of those cylinders A and B is 3 : 1. The ratio of the volumes of the cylinders A and B is

[A] 12 : 35
[B] 12 : 25
[C] 25 : 12
[D] 35 : 12

81. A number is such that when it is multiplied by 8, it gives another number which is as much more than 153 as the original number itself is less than 153. The 25% of the original number is

[A] 7.5
[B] 7
[C] 8
[D] 8.5

82. A shopkeeper purchases a product and marks its price up by 40%. He sells the product to a customer at a certain discount, thereby making a profit of 5% on the whole transaction. The percentage of discount offered by the shopkeeper is (in %)

[A] 35
[B] 25
[C] 15
[D] 12\(\frac{1}{2}\)

83. A box contains 280 coins of one rupee, 50 paisa and 25 paisa. The values of each kind of coin are in the ratio of 8 : 4 : 3. The number of 25 paisa coins is

[A] 80
[B] 120
[C] 100
[D] 135

84. ₹800 amounts to ₹920 in 3 years at simple interest. If the interest rate is increased by 3%, it would amount to how much?

[A] ₹1,056
[B] ₹1,112
[C] ₹1,182
[D] ₹992
85. The HCF and LCM of two natural numbers are 12 and 72 respectively. What is the difference between two numbers, if one of the numbers is 24?

[A] 12  
[B] 18  
[C] 21  
[D] 24

86. In a school, all the students can stand in a row so that each row has 5, 9 or 10 students. Find the least number of students in the school.

[A] 90  
[B] 95  
[C] 85  
[D] 100

87. A vessel contains 180 litres of a mixture of milk and water in the ratio 13:5. 54 litres of this mixture was taken out and replaced with 6 litres of water. The percentage of water in the resultant mixture is

[A] 41%  
[B] 24%  
[C] 17%  
[D] 31%

88. A can complete a piece of work in 24 days while B is twice as efficient as he. A started initially and was joined by B after X days. If the whole work was completed in 10 days, the value of X is

[A] 7 days  
[B] 5 days  
[C] 6 days  
[D] 3 days

89. If each edge of a cube is decreased by 30%, then the percentage of decrease in the volume of that cube is

[A] 62.5%  
[B] 63.5%  
[C] 65.7%  
[D] 67.7%

90. The cost prices of two watches are equal. One watch was sold at a profit of 30% and the other one for ₹5,504 less than the first one. If the overall profit earned after selling both the watches is 14%, the cost price of each watch is (in ₹)

[A] 17,200  
[B] 17,680  
[C] 17,000  
[D] 16,800
91. Deepak is brother of Ravi. Reena is sister of Atul. Ravi is son of Reena. Then Deepak is related to Reena as

[A] son  
[B] brother  
[C] nephew  
[D] father

92. Six volumes labelled $P$, $Q$, $R$, $S$, $T$ and $U$ are kept side-by-side on a shelf. $Q$, $R$, $T$, $U$ have green covers while the other have yellow covers. $P$, $S$ and $Q$ are new volumes while the rest are old volumes. $P$, $R$, $S$ are law reports while the rest are medical reports. Then the two volumes of old medical reports and having green covers are

[A] $Q$ and $R$  
[B] $R$ and $S$  
[C] $R$ and $T$  
[D] $T$ and $U$

93. The missing term of the following series

4, 10, ___, 82, 244, 730

is

[A] 24  
[B] 28  
[C] 77  
[D] 218

94. Vehicle is related to Caravan in the same way as Player is related to

[A] Coach  
[B] Captain  
[C] Team  
[D] Field

95. If `+` stands for `division`, `×` stands for `multiplication`, `–` stands for `subtraction` and `-` stands for `addition`, which of the following is correct?

[A] $18 + 6 \times 7 + 5 - 2 = 22$  
[B] $18 \times 6 + 7 + 5 - 2 = 16$  
[C] $18 + 6 - 7 + 5 \times 2 = 20$  
[D] $18 + 6 + 7 \times 5 - 2 = 18$

96. In a certain code, EAT is written as 318 and CHAIR is written as 24156. Then TEACHER will be written as

[A] 8312436  
[B] 8312346  
[C] 8321436  
[D] 8313426
Directions (Question Nos. 97 to 100): Read the information given below and answer the questions that follow.

Four young men Raj, Prem, Ved and Ashok are friendly with four girls Sushma, Kushum, Vimla and Poonam. Sushma and Vimla are friends. Ved’s girlfriend does not like Sushma and Vimla. Kushum does not care for Ved. Prem’s girlfriend is friendly with Sushma. Sushma does not like Raj.

97. Raj’s girlfriend is

[A] Sushma  
[B] Kushum  
[C] Vimla  
[D] Poonam

98. Sushma is friendly with

[A] Raj  
[B] Prem  
[C] Ved  
[D] Ashok

99. Poonam’s boyfriend is

[A] Ashok  
[B] Prem  
[C] Ved  
[D] Raj

100. The person who does not like Sushma and Vimla is

[A] Poonam  
[B] Raj  
[C] Ashok  
[D] Ved

101. If ‘train’ is called ‘bus’, ‘bus’ is called ‘tractor’, ‘tractor’ is called ‘car’, ‘car’ is called ‘scooter’, ‘scooter’ is called ‘bicycle’ and ‘bicycle’ is called ‘moped’, then which is used to plough a field?

[A] Train  
[B] Bus  
[C] Tractor  
[D] Car

Directions (Question Nos. 102 to 106): Study the following information and answer the questions given below.

All the six members of a family P, Q, R, S, T and U are travelling together. Q is the son of R but R is not the mother of Q. P and R are married couple. T is the brother of R. S is the daughter of P. U is the brother of Q.

102. The number of male members in the family is

[A] one  
[B] three  
[C] four  
[D] five
103. The mother of Q is

[A] S
[B] U
[C] T
[D] P

104. The number of children of P is

[A] four
[B] three
[C] two
[D] one

105. How is T related to S?

[A] Father
[B] Brother
[C] Uncle
[D] None of the above

106. Which of the following is a pair of females?

[A] P and T
[B] Q and S
[C] S and U
[D] P and S

107. One morning after sunrise, Reeta and Kavita were talking to each other face-to-face at Tilak Square. If Kavita’s shadow was exactly to the right of Reeta, the direction in which Kavita was facing is

[A] North
[B] South
[C] East
[D] West

108. One morning after sunrise, Vikram and Sailesh were standing on a lawn with their backs towards each other. Vikram’s shadow fell exactly towards his left-hand side. The direction in which Sailesh was facing is

[A] East
[B] South
[C] West
[D] North

109. A man is performing Yoga with his head down and legs up. His face is towards the West. The direction in which his right hand will be

[A] North
[B] West
[C] South
[D] East
110. One morning after sunrise, Gopal was standing facing a pole. The shadow of the pole fell exactly to his right. The direction in which Gopal was facing is

[A] South  
[B] North  
[C] East  
[D] West

111. In a group of cows and hens, the number of legs is 14 more than twice the number of heads. The number of cows is

[A] 5  
[B] 7  
[C] 10  
[D] 12

Directions (Question Nos. 112 to 114): The diagram below shows the number of students who got distinction in three subjects out of 500 students. Study the diagram carefully and answer the questions that follow.

![Diagram showing the number of students who got distinction in three subjects]

112. The percentage of students who got distinction in two subjects is

[A] 8%  
[B] 9%  
[C] 10%  
[D] 12%

113. The percentage of students who got distinction is

[A] 28%  
[B] 35%  
[C] 38%  
[D] 40%

114. The percentage of students who got distinction marks in Mathematics is

[A] 17.8%  
[B] 18.6%  
[C] 19.2%  
[D] 20.6%

115. In a group of 15 students, 7 can read French, 8 can read English while 3 of them can read none of these two. The number of students who can read both French and English is

[A] 2  
[B] 3  
[C] 4  
[D] 5
116. There are 50 students admitted to a nursery class. Some students can speak in only English and some can speak in only Hindi. 10 students can speak in both English and Hindi. If the number of students who can speak in English is 21, then the number of students who can speak in only English is (assume each student can speak in at least one language)

[A] 10
[B] 11
[C] 29
[D] 39

**Directions** (Question Nos. 117 to 120): Read the following information carefully and answer the questions that follow.

(i) Six persons $P$, $Q$, $R$, $S$, $T$ and $U$ are sitting in two rows, three in each.

(ii) $T$ is not at the end of any row.

(iii) $S$ is second to the left of $U$.

(iv) $R$, the neighbor of $T$, is sitting diagonally opposite to $S$.

(v) $Q$ is the neighbor of $U$.

117. Which of the following are sitting diagonally opposite to each other except $R$ and $S$?

[A] $U$ and $R$
[B] $S$ and $P$
[C] $P$ and $R$
[D] $P$ and $U$

118. Which of the following are in the same row?

[A] $P$ and $T$
[B] $T$ and $S$
[C] $R$ and $Q$
[D] $P$ and $Q$

119. Which of the following is in one of the two rows?

[A] $UQR$
[B] $RTQ$
[C] $SQU$
[D] $PTU$

120. After interchanging seat with $T$, will be the neighbor of $S$ in the new position?

[A] $R$ and $P$
[B] $U$ and $Q$
[C] Only $Q$
[D] Only $R$
121. Choose the correct antonym to the word in capital letters: REVEAL
   [A] Let slip
   [B] Conceal
   [C] Hide
   [D] Disclose

122. Ocean is to ___ as tree is to leaf.
   [A] pond
   [B] river
   [C] waterfall
   [D] fountain

123. Choose the correct synonym to the word in capital letters: ASSASSINATION
   [A] Genocide
   [B] Suicide
   [C] Death
   [D] Homicide

124. She started arguing ___ a cup of tea.
   [A] in
   [B] on
   [C] over
   [D] beside

125. The past participle of wake is
   [A] woken
   [B] woke
   [C] woked
   [D] waking

126. She was so exhausted that she ___ down for a nap.
   [A] slept
   [B] lay
   [C] laid
   [D] lying

127. The passive voice for the sentence “A bolt of lightning struck the transformer” is
   [A] A bolt of lightning was struck by the transformer.
   [B] The transformer was struck by a bolt of lightning.
   [C] The transformer struck the bolt of lightning.
   [D] The bolt of lightning was striking the transformer.

128. The cup is placed ___ the table.
   [A] in
   [B] out
   [C] aside
   [D] on
129. The officer instructed the driver ___ change the direction of the car.

[A] to
[B] while
[C] as
[D] by

130. There is great joy in ___ gifts.

[A] to receive
[B] received
[C] receive
[D] receiving

131. You ___ to school early this morning.

[A] come
[B] coming
[C] came
[D] was coming

132. Choose the correct antonym of the word in capital letters: QUANDARY

[A] Difficulty
[B] Decisiveness
[C] Puzzled
[D] Clear

133. Choose the correct synonym of the word in capital letters: PROFUSE

[A] Little
[B] Minimum
[C] Abundant
[D] Transfuse

134. The ___ of wolves was hungry.

[A] pack
[B] herd
[C] flock
[D] cluster

135. I ___ to study linguistics when I was a graduate student.

[A] beginning
[B] began
[C] begun
[D] begin

136. The meaning of ‘optimal’ is

[A] better
[B] reasonable
[C] favourable
[D] adaptable
137. Day is to ___ as summer is to winter.

[A] warmth
[B] sun
[C] noon
[D] night

138. Walking is to ___ as sleeping is to resting.

[A] running
[B] movement
[C] hiking
[D] standing

139. Gestures are means of communication, ___ they are essential for the hearing impaired.

[A] yet
[B] but
[C] moreover
[D] however

140. The past progressive in the sentence “Ray — a brand new car” is

[A] drove
[B] driven
[C] was driving
[D] had been driving

141. We could ___ in English when we were at school.

[A] speaking
[B] speak
[C] spoke
[D] speaker

142. Which of the following is the correct sentence?

[A] Inna should not have gone the party last night.

[B] Inna should have not gone to the party last night.

[C] Last night Inna should not gone to the party.

[D] Inna not should have gone to the party last night.

143. Which of the following is the correct sentence?

[A] They did not planted the corn this year.

[B] They do not planted the corn this year.

[C] They did not plant the corn this year.

[D] They does not plant the corn this year.
144. Which of the following is the correct sentence?

[A] Mother carefully wrapped the gift.
[B] Mother wrapped carefully the gift.
[C] Mother wrapped the carefully gift.
[D] Carefully mother wrapped the gift.

145. Add _____ salt to the curry.

[A] any
[B] more to
[C] to plenty
[D] a little

146. Kindness _____ a virtue.

[A] was
[B] are
[C] am
[D] is

147. Mountain is to _____ as fire is to water.

[A] hill
[B] forest
[C] sea
[D] land

148. Choose the correct antonym of the word in capital letters: FAITH

[A] Devotion
[B] Trust
[C] Disbelief
[D] Reliance

149. Which word does not belong with the others?

[A] Tiger
[B] Wolf
[C] Lion
[D] Elephant

150. Which word does not belong with the others?

[A] Kilogram
[B] Milligram
[C] Kilometer
[D] Mile